OptiSystem
Getting Started
Optical Communication System Design Software
Version 7.0
for Windows® XP/Vista
# Technical support

If you purchased Optiwave software from a distributor that is not listed here, please send technical questions to your distributor.

<table>
<thead>
<tr>
<th>Optiwave</th>
<th>Canada/US</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tel</td>
<td>(613) 224-4700</td>
</tr>
<tr>
<td>Fax</td>
<td>(613) 224-4706</td>
</tr>
<tr>
<td>E-mail</td>
<td><a href="mailto:support@optiwave.com">support@optiwave.com</a></td>
</tr>
<tr>
<td>URL</td>
<td><a href="http://www.optiwave.com">www.optiwave.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cybernet Systems Co., Ltd.</th>
<th>Japan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tel</td>
<td>+81 (03) 5978-5414</td>
</tr>
<tr>
<td>Fax</td>
<td>+81 (03) 5978-6082</td>
</tr>
<tr>
<td>E-mail</td>
<td><a href="mailto:owtech@cybernet.co.jp">owtech@cybernet.co.jp</a></td>
</tr>
<tr>
<td>URL</td>
<td><a href="http://www.cybernet.co.jp">www.cybernet.co.jp</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Optiwave Europe</th>
<th>Europe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tel</td>
<td>+33 (0) 494 08 27 97</td>
</tr>
<tr>
<td>Fax</td>
<td>+33 (0) 494 33 65 76</td>
</tr>
<tr>
<td>E-mail</td>
<td><a href="mailto:support@optiwave.com">support@optiwave.com</a></td>
</tr>
<tr>
<td>URL</td>
<td><a href="http://www.optiwave.eu">www.optiwave.eu</a></td>
</tr>
</tbody>
</table>
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing OptiSystem</td>
<td>1</td>
</tr>
<tr>
<td>Hardware and software requirements</td>
<td>1</td>
</tr>
<tr>
<td>Protection key</td>
<td>1</td>
</tr>
<tr>
<td>OptiSystem directory</td>
<td>2</td>
</tr>
<tr>
<td>Installation</td>
<td>2</td>
</tr>
<tr>
<td>Technical support</td>
<td>2</td>
</tr>
<tr>
<td>What's New in OptiSystem 7.0</td>
<td>3</td>
</tr>
<tr>
<td>Comprehensive Multimode Library</td>
<td>3</td>
</tr>
<tr>
<td>Sophisticated Amplifier Library</td>
<td>3</td>
</tr>
<tr>
<td>Component Libraries</td>
<td>4</td>
</tr>
<tr>
<td>GUI and Integrated Design Environment</td>
<td>5</td>
</tr>
<tr>
<td>Application and Validation Projects</td>
<td>6</td>
</tr>
<tr>
<td>Features introduced in OptiSystem 6.0</td>
<td>7</td>
</tr>
<tr>
<td>Component Libraries</td>
<td>7</td>
</tr>
<tr>
<td>GUI and Integrated Design Environment</td>
<td>9</td>
</tr>
<tr>
<td>Introduction</td>
<td>11</td>
</tr>
<tr>
<td>Benefits</td>
<td>13</td>
</tr>
<tr>
<td>Applications</td>
<td>13</td>
</tr>
<tr>
<td>Main features</td>
<td>14</td>
</tr>
</tbody>
</table>
Installing OptiSystem

Before installing OptiSystem, ensure the system requirements described below are available.

Hardware and software requirements

OptiSystem requires the following minimum system configuration:
• PC with Pentium 3 processor or equivalent
• Microsoft Windows XP or Vista. 32-bit or 64-bit.
• 400 MB free hard disk space
• 1024 x 768 graphic resolution, minimum 65536 colors
• 128 MB of RAM (recommended)
• Internet Explorer 5.5 or higher
• DirectX 8.1 or higher

Protection key

A hardware protection key is supplied with the software.

**Note:** Please ensure that the hardware protection key is NOT connected during the installation of OptiSystem.

To ensure that OptiSystem operates properly, verify the following:
• The protection key is properly connected to the parallel/USB port of the computer.
• If you use more than one protection key, ensure that there is no conflict between the OptiSystem protection key and the other keys.

**Note:** Use a switch box to prevent protection key conflicts. Ensure that the cable between the switch box and the computer is a maximum of one meter long.
Installing OptiSystem

OptiSystem directory

By default, the OptiSystem installer creates an OptiSystem directory on your hard disk. The OptiSystem directory contains the following subdirectories:

- `\bin` — executable files, dynamic linked libraries, and help files
- `\components` — OptiSystem component parameters from vendors
- `\doc` — OptiSystem support documentation
- `\libraries` — OptiSystem component libraries
- `\samples` — OptiSystem example files
- `\toolbox` — MATLAB related files

*Note:* For the users of the Amplifier Edition of OptiSystem, refer to the `Optical Amplifiers` folder under `\Samples`. For the users of the Multimode Edition of OptiSystem, refer to the `\Multimode` folder under `\Samples`.

Installation

OptiSystem can be installed on Windows XP or Vista. We recommend that you exit all Windows programs before running the setup program.

Windows XP or Vista installation

To install OptiSystem on Windows XP or Vista, perform the following procedure.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Log on as the Administrator, or log onto an account with Administrator privileges.</td>
</tr>
<tr>
<td>2</td>
<td>Insert the OptiSystem CD into your CD ROM drive.</td>
</tr>
<tr>
<td>3</td>
<td>On the Taskbar, click <strong>Start</strong> and select <strong>Run</strong>. The <strong>Run</strong> dialog box appears.</td>
</tr>
<tr>
<td>4</td>
<td>In the <strong>Run</strong> dialog box, type <code>F:\setup.exe</code>, where <code>F</code> is your CD ROM drive.</td>
</tr>
<tr>
<td>5</td>
<td>Click <strong>OK</strong> and follow the screen instructions and prompts.</td>
</tr>
<tr>
<td>6</td>
<td>When the installation is complete, reboot your computer.</td>
</tr>
</tbody>
</table>

Technical support

<table>
<thead>
<tr>
<th>Phone</th>
<th>(613) 224-4700—Monday to Friday, 8:30 a.m. to 5:30 p.m. Eastern Standard Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax</td>
<td>(613) 224-4706</td>
</tr>
<tr>
<td>E-Mail</td>
<td><a href="mailto:support@optiwave.com">support@optiwave.com</a></td>
</tr>
<tr>
<td>URL</td>
<td><a href="http://www.optiwave.com">www.optiwave.com</a></td>
</tr>
</tbody>
</table>
What’s New in OptiSystem 7.0

The most comprehensive optical communication design suite for optical system design engineers is now even better with the release of OptiSystem version 7.0 - now available in 32-bit and TRUE 64-bit versions.

The latest version of OptiSystem features a number of new features and enhancements to address the design of WDM passive optical networks (WDM-PON) based FTTx, Optical CDMA and radio over fiber systems (RoF).

Comprehensive Multimode Library

OptiSystem Multimode Edition allows the design, analysis and simulation of multimode fiber communication systems.

The Multimode Component Library of OptiSystem includes a new option to load modal attenuation measurements of multimode fibers. A new calculation method to estimate differential mode delays for multimode fibers offers more accuracy than traditional method based on derivatives.

Users can also select whether to use the direct integration of the Rayleigh-Sommerfeld integrals when using spatial connectors for free-space propagation.

Sophisticated Amplifier Library

OptiSystem Amplifier Edition allows computer-aided design of a variety of waveguide and fiber optic amplifiers. OptiSystem assists the user in determining the tradeoff between EDFAs, EYDFs, EYDWs, YDFs, SOAs and Raman amplifiers cost and performance.

New graphs were added to the doped fiber amplifiers to allow the visualization of the time domain ASE power.

The Amplifiers library in OptiSystem also includes a new reflective semiconductor optical amplifier that allows the modulation and detection of optical signals.

1 The ‘TRUE 64-bit’ edition of Optiwave software products are 64-bit applications written specifically for next generation operating systems. The newly optimized code structure results in improved computing performance and efficient memory utilization. Users are now capable of running large scale ‘real world’ simulations, without memory restrictions limited to 32-bit applications.
What’s New in OptiSystem 7.0

Component Libraries:

Optical Sources

- Spatiotemporal VCSEL: A new laser model based on 2D spatially-dependent rate equations that account dynamically for the spatial interactions between the optical field and carrier distributions in the active layer.
- VCSEL Laser: An improved parameter fit method allows for a more accurate estimation of laser parameters from the LI and VI curve measurements.
- Laser Measured: Allows loading the IM response file and calculates the damping factor and resonance frequency factor. Improved Parameter fitting and includes the option to use the carrier lifetime parameter or the Recombination coefficients (linear, bimolecular and Auger).
- Laser Rate Equations: Includes the option to use the carrier lifetime parameter or the Recombination coefficients (linear, bimolecular and Auger).

Signal Processing

- Optical Downsampler, Signal Type Selector, Convert To Sampled Signals, Channel Attacher: New components allows users to have more control over sampled, parameterized signals and noise bins.
- Predistortion: A new component for predistortion of electrical signals. The component can inversely model an optical modulator’s amplitude and phase characteristics.
- Integrate And Dump: This component creates a cumulative sum of the discrete-time input signal. It also resets the sum to zero according to a user defined time period.
- Mode Selector: This new component converts a multimode signal into a single mode signal.

Optical Passives

- Time Delay: a new parameter defines whether to include the carrier phase shift or not.
- Polarization Waveplate: The new waveplate component offers control of the rotation angle and phase change of the polarization of optical signals.
- Spatial Connector: A new parameter allows the user to select whether to use Fast Fourier Transform or the direct integration method of the Rayleigh-Sommerfeld integrals.

Optical Fibers

- Multimode Fibers: Users can select a new and more accurate method to calculate the differential mode delay based on the variation principle. User defined modal attenuation was also added to the multimode fiber.
Pulse Generators
• M-ary Raised Cosine Pulse Generator: A new pulse generator subsystem encapsulates an m-ary pulse generator and a raised cosine filter for CATV applications.

Filters
• Optical and Electrical Analytical filters: A new IIR filter engine for individual samples improves the accuracy of analytical filters such as Butterworth, Bessel and Chebyshev filters.

Optical Amplifiers
• Reflective SOA: Includes a new semiconductor optical amplifier component that can be used to modulate or detect optical signals.

Visualizers
• Constellation diagram: Constellation and polar diagrams includes a new calculation engine to estimate Error Vector Magnitude based on symbol targets.
• Optical Time Domain Visualizer: A new parameter allows for the selection of an individual mode and polarization when working with multimode signals.

GUI and Integrated Design Environment:
• OptiSystem TRUE-64 Bits: OptiSystem 7.0 introduces the first TRUE-64 bits optical system simulator integrated environment. It allows for the design and simulation of optical systems without the memory restrictions of 32 bits Windows.
• Script Editor: A robust text editor that is fully integrated with the Windows operating system, allowing it to take advantage of all system resources. It automatically uses color coding to separately identify instructions and operands, thereby making it easier to read and interpret the VBScript code.
• Project Browser: A new project browser allows for much faster calculation and updates of components parameters, results and graphs.
• Dispersion Maps: Accumulated dispersion was added to the list of signals parameters that can be traced when using lite monitors. It allows for plotting of dispersion maps. Users can also add dispersion maps to the report page.
• Multiple Parameter and Results Optimization: A new multiple parameter and result optimization numerical engine and user interface.
• Multiline Text Label Tool: Text tool was extended to allow for multiline text.

Application and Validation Projects:
Additional applications and validation projects were added to the OptiSystem documentation and sample files, covering broadband optical system based on a passive optical network, electronic equalization, new modulation formats, radio over fiber, optical CDMA, coherent optical transmission, free-space optics and much more.
WHAT'S NEW IN OPTISYSTEM 7.0

Notes:
Features introduced in OptiSystem 6.0

Component Libraries

Optical Sources

- VCSEL Laser and Laser Rate Equations: A new adaptive step engine allows for fast convergence of high frequency analog signals.

CATV Carrier Generators

- Carrier Generator: New parameters include the ability to enable or disable specific channels, facilitating the measurements of carrier to noise ratio (CNR).
- Carrier Generator Measured: A new list of pre-defined set of standard carrier spacing allows for easy setting up of PAL GB (up to 97 channels), NTSC (up to 157 channels) and L (up to 58 channels) systems.

Optical Fibers

- Bidirectional Optical Fibers: A new discretization parameter for broadband sampled signals offers improved performance, accuracy, and convergence for doped amplifier gain and Brillouin calculations.
- Multimode Fiber: Load measured group delays using the Cambridge file format, conforming to the current standards and extending the capabilities of Gigabit Ethernet simulations in OptiSystem.

Amplifiers

- Wideband Traveling Wave SOA: Flexible selection between a static or dynamic model.

Multiplexers

- AWG NxN Bidirectional: A sophisticated new AWG model facilitates the design of AWG based PON using the unique bidirectional capabilities of OptiSystem.

Microwave components

- 180 and 90 Degree Hybrid Couplers, DC blockers, power splitters and combiners: A new component library geared for ROF applications. Applications include mixers, power combiners, dividers, modulators, and phased array radar antenna systems. Control amplitude and phase balance of different components.
- Measured components: Bidirectional S-parameters components allow users to load s1p, s2p, s3p and s4p file formats, including s2p with noise figure data.

Passives

- Polarization Delay and Phase Shift components: New components which control the delay and phase shift for each polarization. Control the delay calculation, by using linear or discrete delay.
FEATURES INTRODUCED IN OPTISYSTEM 6.0

- Periodic Optical Filter: A new multi-band optical filter with user defined transmission function.

Regenerators
- MLSE (maximum likelihood sequence estimate) Electronic Equalizer: Introducing an advanced component feature using the Viterbi algorithm to equalize the input signal through a dispersive channel.

Free Space Optics
- OWC (Optical Wireless Communication) Channel: A subsystem of two telescopes and the optical wireless channel between them facilitating the simulation of intersatellite communication links.

Test sets
- Advanced photonic all-parameter analyzer: Measure polarization mode dispersion (PMD) and records multiple traces simultaneously. This new component can measure insertion loss (IL), differential group delay (DGD), polarization chromatic dispersion (PDC), depolarization rate, dispersion, dispersion slope, and group delay (GD).
- S-Parameter Extractor: For electronic component or subsystem characterization. The signal characteristics from an optical transmitter input and receiver output can be extracted and exported into an industry standard touchstone format for s-parameters, benefiting EDA tools that offer integrated s-parameter support and shortening the design cycle time.
- Optical Filter Analyzer: A new time domain calculation option estimates the power transmission response of optical devices. It can also calculate the power impulse response of multimode fibers.

Visualizers
- Color Grade Option: Simulate persistence modes using different color schemes to represent the total number (density) of data counts acquired on a user defined region (time and amplitude display coordinate) of the display graph.
- Invert Color Option: A 'measurement instrument' look-and-feel for visualizers.
- Polarization meter: A new visualizer which displays the average polarization state of the optical signal. Includes DOP, Stokes parameters, Azimuth, and Ellipticity
- Constellation diagram: Constellation and polar diagrams includes a new calculation engine to estimate symbol error in user defined regions and targets.
- Eye and BER Analyzer: Eye diagrams with color grades and histogram analysis in user defined regions. Includes user defined FEC gain curve, jitter measurements, and eye masks in accordance with Agilent standard file format.
- Frequency domain (OSA and RF Analyzer): New phase, group delay and dispersion (optical) graphing feature.
- Time Domain (OTM and Oscilloscope): New autocorrelation, alpha parameter (optical), and FROG (Frequency Resolved Optical Gating) graphing feature.
- Optical Power meter: New measurements which include the X and Y polarization components of signals and noise.
• Electrical Power meter: New measurements which include the AC and DC components of signals and noise.

GUI and Integrated Design Environment:

• Display Results: Users can now select results to be displayed in the layout. Results can be set to trigger alarms indicating if a result is out of a pre-defined range. Improved Project Browser to setup and display results.

• Project Export: Export current list of components, parameters and results directly to Excel. Includes the option to export an OptiSystem file directly to a compressed file format.

• Memory Management: Enable/disable signal monitors and graphs to save memory when using large number of iteration sweeps.

• Nested Parameter Sweeps: In addition to the standard OptiSystem parallel sweep and the script editor, OptiSystem supports nested parameter sweeps. Combined with the report page, users can easily build 2D and 3D graphs using different nesting levels.

• Component Viewer: The new component viewer allows for easy access to component results and graphs.

• Component Script: Write your own calculation engine. For example, a new result can be added to a component or visualizer, offering unlimited possibilities in terms of post-processing. Script can access component parameters, results and graphs.
FEATURES INTRODUCED IN OPTI SYSTEM 6.0

Notes:
Introduction

Optical communication systems are increasing in complexity on an almost daily basis. The design and analysis of these systems, which normally include nonlinear devices and non-Gaussian noise sources, are highly complex and extremely time-intensive. As a result, these tasks can now only be performed efficiently and effectively with the help of advanced new software tools.

OptiSystem is an innovative optical communication system simulation package that designs, tests, and optimizes virtually any type of optical link in the physical layer of a broad spectrum of optical networks, from analog video broadcasting systems to intercontinental backbones.

OptiSystem is a stand-alone product that does not rely on other simulation frameworks. It is a system level simulator based on the realistic modeling of fiber-optic communication systems. It possesses a powerful new simulation environment and a truly hierarchical definition of components and systems. Its capabilities can be extended easily with the addition of user components, and can be seamlessly interfaced to a wide range of tools.

A comprehensive Graphical User Interface (GUI) controls the optical component layout and netlist, component models, and presentation graphics (see Figure 1 on page 18).

The extensive library of active and passive components includes realistic, wavelength-dependent parameters. Parameter sweeps allow you to investigate the effect of particular device specifications on system performance.

Created to address the needs of research scientists, optical telecom engineers, system integrators, students, and a wide variety of other users, OptiSystem satisfies the demand of the booming photonics market for a powerful and easy-to-use optical system design tool.

OptiSystem is also available in two additional configurations:

• Amplifier Edition
• Multimode Edition
The features included in each of these configurations are listed below.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Editor</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Report Page</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Scripting capabilities</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>MATLAB interface</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Parameter Optimization</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Export to OptiPerformer</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Mode Fibers</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Multimode Fibers</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>CATV</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>EDA Co-simulation</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Multimode Components</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Doped Fibers</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Waveguide Amplifiers</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>SOA Amplifiers</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Raman Amplifiers</td>
<td></td>
<td></td>
<td>•</td>
</tr>
</tbody>
</table>
INTRODUCTION

Benefits

• Rapid, low-cost prototyping
• Global insight into system performance
• Straightforward access to extensive sets of system characterization data
• Automatic parameter scanning and optimization
• Assessment of parameter sensitivities aiding design tolerance specifications
• Dramatic reduction of investment risk and time-to-market
• Visual representation of design options and scenarios to present to prospective customers

Applications

OptiSystem allows for the design automation of virtually any type of optical link in the physical layer, and the analysis of a broad spectrum of optical networks, from long-haul systems to MANs and LANs.

OptiSystem’s wide range of applications include:

• Optical communication system design from component to system level at the physical layer
• CATV or TDM/WDM network design
• Passive optical networks (PON) based FTTx
• Free space optic (FSO) systems
• Radio over fiber (ROF) systems
• SONET/SDH ring design
• Transmitter, channel, amplifier, and receiver design
• Dispersion map design
• Estimation of BER and system penalties with different receiver models
• Amplified system BER and link budget calculations
### Main features

The main features of the OptiSystem interface include:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Component Library</strong></td>
<td>To be fully effective, component modules must be able to reproduce the actual behavior of the real device and specified effects according to the selected accuracy and efficiency. The OptiSystem Component Library includes hundreds of components, all of which have been carefully validated in order to deliver results that are comparable with real life applications.</td>
</tr>
<tr>
<td><strong>Measured components</strong></td>
<td>The OptiSystem Component Library allows you to enter parameters that can be measured from real devices. It integrates with test and measurement equipment from different vendors.</td>
</tr>
<tr>
<td><strong>Integration with Optiwave Software Tools</strong></td>
<td>OptiSystem allows you to employ specific Optiwave software tools for integrated and fiber optics at the component level: OptiAmplifier, OptiBPM, OptiGrating, WDM_Phasar, and OptiFiber.</td>
</tr>
<tr>
<td><strong>Mixed signal representation</strong></td>
<td>OptiSystem handles mixed signal formats for optical and electrical signals in the Component Library. OptiSystem calculates the signals using the appropriate algorithms related to the required simulation accuracy and efficiency.</td>
</tr>
<tr>
<td><strong>Quality and performance algorithms</strong></td>
<td>In order to predict the system performance, OptiSystem calculates parameters such as BER and Q-Factor using numerical analysis or semi-analytical techniques for systems limited by inter symbol interference and noise.</td>
</tr>
<tr>
<td><strong>Advanced visualization tools</strong></td>
<td>Advanced visualization tools produce OSA Spectra, signal chirp, eye diagrams, polarization state, constellation diagrams and much more. Also included are WDM analysis tools listing signal power, gain, noise figure, and OSNR per channel.</td>
</tr>
<tr>
<td><strong>Data monitors</strong></td>
<td>You can select component ports to save the data and attach monitors after the simulation ends. This allows you to process data after the simulation without recalculating. You can attach an arbitrary number of visualizers to the monitor at the same port.</td>
</tr>
<tr>
<td><strong>Hierarchical simulation with subsystems</strong></td>
<td>To make a simulation tool flexible and efficient, it is essential to provide models at different abstraction levels, including the system, subsystem, and component levels. OptiSystem features a truly hierarchical definition of components and systems, enabling you to employ specific software tools for integrated and fiber optics at the component level, and allowing the simulation to be as detailed as the desired accuracy dictates.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User-defined components</td>
<td>You can incorporate new components based on subsystems and user-defined libraries, or use co-simulation with a third party tool such as MATLAB.</td>
</tr>
<tr>
<td>Powerful Script language</td>
<td>You can enter arithmetical expressions for parameters and create global parameters that can be shared between components and subsystems using standard VB Script language. The script language can also manipulate and control OptiSystem, including calculations, layout creation and post-processing when using the script page.</td>
</tr>
<tr>
<td>State-of-the-art calculation data-flow</td>
<td>The Calculation Scheduler controls the simulation by determining the order of execution of component modules according to the selected data flow model. The main data flow model that addresses the simulation of the transmission layer is the Component Iteration Data Flow (CIDF). The CIDF domain uses run-time scheduling, supporting conditions, data-dependent iteration, and true recursion.</td>
</tr>
<tr>
<td>Multiple layouts</td>
<td>You can create many designs using the same project file, which allows you to create and modify your designs quickly and efficiently. Each OptiSystem project file can contain many design versions. Design versions are calculated and modified independently, but calculation results can be combined across different versions, allowing for comparison of the designs.</td>
</tr>
<tr>
<td>Report page</td>
<td>A fully customizable report page allows you to display any set of parameters and results available in the design. The produced reports are organized into resizable and moveable spreadsheets, text, 2D and 3D graphs. It also includes HTML export and templates with pre-formatted report layouts.</td>
</tr>
<tr>
<td>Parameter sweeps and optimizations</td>
<td>Simulations can be repeated with an iterated variation of the parameters. OptiSystem can also optimize any parameter to minimize or maximize any result or can search for target results. You can combine multiple parameter sweeps and multiple optimizations.</td>
</tr>
<tr>
<td>OptiPerformer</td>
<td>For any given system topology and component specification scenario, a full OptiSystem project can be encrypted and exported to OptiPerformer. OptiPerformer users can then vary any parameter within defined specification ranges, and observe resulting system effects via detailed graphics and reports.</td>
</tr>
<tr>
<td>Bill of materials</td>
<td>OptiSystem provides a cost analysis table of the system being designed, arranged by system, layout or component. Cost data can be exported to other applications or spreadsheets.</td>
</tr>
</tbody>
</table>
INTRODUCTION

Notes:
Quick Start

This section describes how to load a design, run a simulation, edit local and global parameters, and obtain results. The most efficient way to become familiar with OptiSystem is to complete the lessons in the Tutorials, where you learn how to use the software by solving problems.

Note: For the users of the Amplifier Edition of OptiSystem we recommend to follow Lesson 7: Optical Amplifiers - Designing optical fiber amplifiers and fiber lasers, and for the users of the Multimode Edition of OptiSystem we recommend to follow Lesson 8: Optical Systems - Working with multimode components. Both lessons are available in the OptiSystem tutorials book.

Starting OptiSystem

To start OptiSystem, perform the following action.

Action

- From the Start menu, select Programs > Optiwave Software > OptiSystem 7 > OptiSystem.
  
  OptiSystem loads and the graphical user interface appears (see Figure 1).
Figure 1  OptiSystem graphical user interface (GUI)
Main parts of the GUI

The OptiSystem GUI contains the following main windows:

- **Project layout**
- **Dockers**
  - Component Library
  - Project Browser
  - Description
- **Status Bar**

**Project layout**

The main working area where you insert components into the layout, edit components, and create connections between components (see Figure 2).

![Project layout window](image-url)
Dockers

Use dockers, located in the main layout, to display information about the active (current) project:

- Component Library
- Project Browser
- Description

Component Library

Access components to create the system design (see Figure 3).

Project Browser

Organize the project to achieve results more efficiently, and navigate through the current project (see Figure 4).
Description
Display detailed information about the current project (see Figure 5).

Figure 5  Description window

Status Bar
Displays project calculation progress information, useful hints about using OptiSystem, and other help. Located at the bottom of the Project Layout window.

Figure 6  Status Bar

**Loading a sample file**

To load a sample file, perform the following procedure.

**Step** | **Action**
--- | ---
1 | From the **File** menu, select **Open**.
2 | In **Samples > Introductory Tutorials**, select **Quick Start Direct Modulation.osd**.

The **Direct Modulation** sample file appears in the **Main layout** (see Figure 7).

**Figure 7** Direct Modulation sample file

The transmitter is built using a direct laser modulation scheme, and consists of the following components:

- **Pseudo-Random Bit Sequence Generator**: Sends the bit sequence to the **NRZ Pulse Generator**. The pulses modulate the **Laser Measured**. The **Photodetector PIN** receives the optical signal attenuated by the **Optical Attenuator**. The **Low Pass Bessel Filter** filters the electrical signal.

- **Optical Spectrum Analyzer**: Displays the modulated optical signal in the frequency domain
• **Optical Time Domain Visualizer**: Displays the modulated optical signal in the time domain.

• **Oscilloscope Visualizer**: Displays the electrical signal after the PIN in time domain.

• **BER Analyzer**: Measures the performance of the system based on the signal before and after the propagation.

**Note**: More than one visualizer can be attached to a component output.

### Running a simulation

To run a simulation, perform the following procedure.

**Step** | **Action**
--- | ---
1 | From the **File** menu, select **Calculate** (see Figure 8). *The **OptiSystem Calculations** dialog box appears (see Figure 9).*

**Figure 8  File menu**

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>Layout</th>
<th>Tools</th>
<th>Report</th>
<th>Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open…</td>
<td>Ctrl+O</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As…</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print…</td>
<td>Ctrl+P</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Setup…</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculate…</td>
<td>Ctrl+F5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculate Visualizers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Direct Modulation.osd
2. Quick Start Direct Modulation.osd
3. Question.osd
4. Lixo.osd

Exit
In the **OptiSystem Calculations** dialog box, click the **Run** button (see Figure 9). The results appear in the **Calculation Output** window. The calculation output appears in the **Calculation Output** window, and the simulation results appear below the components that were included in the simulation.
**Displaying results from a visualizer**

To view the simulation results, perform the following action.

**Action**

- Double-click a visualizer in the **Project layout** to view the graphs and results that the simulation generates (see **Figure 10**).

**Figure 10** Optical Time Domain Visualizer results
Component parameters

Viewing and editing component parameters

Double-click a component to view and edit the parameters for the component. To view the properties for Laser Measured, perform the following action.

Action

- In the Project layout, double-click the Laser Measured component. The Laser Measured Properties dialog box appears.

![Laser Measured Properties dialog box](image)

Figure 11  Component parameters – Laser Measured
Component parameters are organized by categories. **Laser Measured** has seven parameter categories, each represented by a tab in the dialog box (see Figure 11).

- Main
- Measurements
- Physical
- Initial estimate
- Simulation
- Noise
- Random numbers

Each category has a set of parameters. Parameters have the following properties:

- Disp
- Name
- Value
- Units
- Mode

The first category in the **Laser Measured** dialog box is **Main**. You can enter the signal **Frequency** and **Power** using the **Main** tab.

The first parameter in the **Main** category is **Disp**. When you select a check box beside a parameter listed in the **Disp** column, the parameter value appears under the component in the **Project layout**. For example, if you select the **Frequency** and **Power** check boxes in the **Disp** column, these parameter values appear in the **Project layout** (see Figure 12).

![Figure 12 Laser Measured with displayed parameter values](image)

Each parameter can have a value in the columns **Name**, **Value**, **Units**, and **Mode**. Some parameters can have different units. For example, you can select the **Frequency** parameter to be in Hz, THz, or nm. When you change your unit selection, the conversion is automatic (see Figure 13).
Figure 13  Choosing parameter values

![Screenshot of the Laser Measured Properties window with parameters set as follows:
- Frequency: 193.1 Hz
- Power: 17.1 mW
- Power at bias current: -3.0 mW
- Bias current: 23 mA
- Modulation peak current: 28 mA

The 'Mode' column for these parameters is set to Normal.
Editing parameters

To edit the NRZ Pulse Generator parameters, perform the following procedure:

**Step** | **Action**
--- | ---
1 | Double-click the NRZ Pulse Generator in the Project layout. *The NRZ Pulse Generator Properties dialog box appears (see Figure 14).*
2 | Click the Simulation tab.

**Figure 14** Laser NRZ Pulse Generator simulation options
For the **Sample rate** parameter, the **Mode** is **Script** (see Figure 15). This parameter will be evaluated as an arithmetic expression. The **Sample rate** parameter of the **Laser Measured** component also refers to a Global parameter with the same name.

**Figure 15** Scripted parameters
**Editing visualizer parameters**

To access the parameters for the **Optical Spectrum Analyzer**, perform the following procedure.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Right-click the <strong>Optical Spectrum Analyzer</strong>. A shortcut menu appears (see Figure 16).</td>
</tr>
</tbody>
</table>

**Figure 16** Shortcut menu

![Shortcut menu]

Select Component Properties. The **Optical Spectrum Analyzer Properties** dialog box appears (see Figure 17).
Figure 17  Optical Spectrum Analyzer Properties dialog box
Global parameters

The global parameters are common to all OptiSystem simulations. (See Appendix A: Global Parameters for more information on global parameters.) In this particular case, you indirectly define the simulation time window, the number of samples, and the sample rate using three parameters:

- Bit rate
- Bit sequence length
- Number of samples per bit

These parameters are used to calculate the Time window, Sample rate, and Number of samples.

- **Time window** = Sequence length * 1/Bit rate = 256 * 1 / 10e9 = 25.6 ns
- **Number of samples** = Sequence length * Samples per bit = 32768 samples
- **Sample rate** = Number of samples / Time window = 1.28 THz

The time window of the simulation is 25.6 ns. 32768 samples will be generated by each component, and the signal bandwidth is 1.28 THz.

OptiSystem shares the parameter Time window with all components. This means that each component works with the same time window. However, each component can work with different sample rates or number of samples (see Figure 18).
### Global parameters values

![Version 1 Parameters](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Units</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation window</td>
<td>Set bit rate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference bit rate</td>
<td>40000000000000</td>
<td>Bits/s</td>
<td>Normal</td>
</tr>
<tr>
<td>Bit rate</td>
<td>276864000</td>
<td>s</td>
<td>Normal</td>
</tr>
<tr>
<td>Time window</td>
<td>276864000</td>
<td>Hz</td>
<td>Normal</td>
</tr>
<tr>
<td>Sample rate</td>
<td>12200000000000</td>
<td>Hz</td>
<td>Normal</td>
</tr>
<tr>
<td>Sequence length</td>
<td>256</td>
<td>Bits</td>
<td>Normal</td>
</tr>
<tr>
<td>Samples per bit</td>
<td>128</td>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td>Number of samples</td>
<td>32768</td>
<td></td>
<td>Normal</td>
</tr>
</tbody>
</table>
Editing global parameters

To edit global parameters, perform the following procedure.

**Step | Action**
---|---
1 | Double-click in the **Project layout**. 
   *The Layout 1 Parameters dialog box appears (see Figure 18).*
2 | Select or clear global parameters as required.

These parameters can be accessed by any component using the script mode. The **NRZ Pulse Generator** refers by default to the global parameter **Sample rate** using script mode (see Figure 19). The **Low Pass Bessel Filter** has the Cutoff parameter frequency as $0.75 \times \text{Bit rate}$. In this case, **Bit rate** is a global parameter (see Figure 20).

![NRZ Pulse Generator properties](image)

Figure 19  NRZ Pulse Generator properties
Figure 20  Low Pass Bessel Filter properties

Low Pass Bessel Filter Properties

Label: Low Pass Bessel Filter
Cost: 0.00

Main

<table>
<thead>
<tr>
<th>Disp</th>
<th>Name</th>
<th>Value</th>
<th>Units</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Cutoff frequency</td>
<td>0.75 * Bit rate</td>
<td>Hz</td>
<td>Script</td>
</tr>
<tr>
<td></td>
<td>Insertion loss</td>
<td>0 dB</td>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Depth</td>
<td>100 dB</td>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Order</td>
<td>4</td>
<td></td>
<td>Normal</td>
</tr>
</tbody>
</table>

Simulation

Evaluate Script

Load...

Save As...

Security...

Help
Using the Layout Editor

In the following example, you will modify a design that you create. You will change the laser modulation scheme from direct to external modulation by replacing some of the components in the design and adding components from the Component Library.

To use the Layout Editor, perform the following procedure.

Step | Action
--- | ---
1 | To delete the Laser Measured component, select the Laser Measured component in the Project layout and press the Delete key. The Laser Measured component is deleted from the layout.
2 | From the Component Library, select Default > Transmitters Library > Optical Sources.
3 | Drag the CW Laser to the Project layout (see Figure 21).

Note: The autoconnect feature automatically connects components in the Project layout. If connections are not made automatically, see “Connecting components manually” on page 39.

Figure 21  CW Laser added to Main Layout
From the Component Library, select Default > Transmitters Library > Optical Modulators.

Drag the Mach-Zehnder Modulator to the Project layout (see Figure 22).

Place the Mach-Zehnder Modulator in the Project layout so the following connections are generated:

a. NRZ Pulse Generator output port to the Mach-Zehnder modulation input port

b. CW Laser output port to the Mach-Zehnder Modulator Carrier input port

c. Mach-Zehnder Modulator output port to the Optical Attenuator input port

Figure 22 Connecting components

Connect the Mach-Zehnder Modulator output port to the Optical Spectrum Analyzer input port and to the Optical Time Domain Visualizer input port (see Figure 23).
From the File menu, select Calculate. The OptiSystem Calculations dialog box appears.

Click the Run button. The results appear in the Calculation Output window.

To view the graphs and results, double-click on the visualizers (see Figure 25 and Figure 26 for examples of visualizer results).

Connecting components manually

To connect components using the layout tool, perform the following procedure.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Place the cursor over the initial port. The cursor changes to the rubber band cursor (chain link) (see Figure 24). A tool tip appears that indicates the type of signal that is available on this port.</td>
</tr>
<tr>
<td>2</td>
<td>Click and drag to the port to be connected. The ports are connected.</td>
</tr>
</tbody>
</table>

Note: You can only connect output to input ports and vice versa.

Figure 24  Rubber Band cursor
Figure 25  Visualizer results — OSA example
Saving the design and closing OptiSystem

To save the design and close OptiSystem, perform the following procedure.

**Step**  **Action**
---
1. From the **File** menu, select **Save**.
   
   *The Quick Start Direct Modulation.osd design is saved.*

2. From the **File** menu, select **Exit**.
   
   *OptiSystem closes.*
Appendix A: Global Parameters

**Opening the global parameters dialog**

To open the global parameters dialog, perform the following action.

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
</table>
| • Double-click in the **Project layout** window.  
  *The Layout Parameters dialog opens (see Figure 27).* |
| OR |
| • Select **Layout > Parameters** from the **Menu** tool bar.  
  *The Layout Parameters dialog opens (see Figure 27).* |

**Editing global parameters**

To edit global parameters, perform the following procedure.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Double-click in the **Project layout**.  
  *The Layout Parameters dialog box appears (see Figure 27).* |
| 2    | Select or clear global parameters as required. |
Figure 27  Layout Parameters dialog

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Units</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation window</td>
<td>Set bit rate</td>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td>Reference bit rate</td>
<td></td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Bit rate</td>
<td>10000000000</td>
<td>Bits/s</td>
<td>Normal</td>
</tr>
<tr>
<td>Time window</td>
<td>1.28e-008</td>
<td>s</td>
<td>Normal</td>
</tr>
<tr>
<td>Sample rate</td>
<td>64000000000</td>
<td>Hz</td>
<td>Normal</td>
</tr>
<tr>
<td>Sequence length</td>
<td>128</td>
<td>Bits</td>
<td>Normal</td>
</tr>
<tr>
<td>Samples per bit</td>
<td>64</td>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td>Number of samples</td>
<td>8192</td>
<td></td>
<td>Normal</td>
</tr>
</tbody>
</table>
When you create a new design, you must define the global simulation parameters. These parameters are critical to the simulation.

They show the speed, accuracy, and memory requirements for a particular simulation during the system design stage. It is important to understand what the global parameters are, because they have an impact on all the components that use these parameters (see Figure 28).

**Figure 28  Global parameters relationships**

![Diagram showing relationships between sample rate, time window, number of samples, frequency spacing, and time spacing.](image)

Time spacing = 1 / Sample rate = Time window / Number of samples

Frequency spacing = 1 / Time window - Sample rate / Number of samples

Time window = Sequence length * Bit period - Sequence length / Bit rate

Number of samples = Sequence length * Samples per bit - Time window * Sample rate
Simulation parameters

Simulation window

Specifies the setup mode for entering the parameters that define the main simulation parameters:

- **Set bit rate**: Allows you to enter the **Bit rate**. This is the default mode — you can easily set up the simulation using typical parameters such as **Bit rate**, **Sequence length**, and **Samples per bit**.
- **Set time window**: Allows you to enter the **Time window** value
- **Set sample rate**: Allows you to enter the **Sample rate**

The parameter **Bit rate** recalculates based on these parameters.
**Reference bit rate**

If this parameter is enabled, when you select **Set time window** or **Set sample rate** in the **Simulation** window, it will find the closest **Time window** or **Sample rate** without changing the **Bit rate**.

**Bit rate**

The value of the global bit rate is in bits per second. All components can access this parameter (see **Figure 30**). The global bit rate can affect components such as Bit sequence generators because components that require this parameter use it as a default value.

An expression relative to this bit rate value is used to define the default value for the bandwidth or cutoff frequency of most electrical filters. When you change this global parameter, you can change the bit rate setting of all modules in the design simultaneously.

**Figure 30**  Global parameter Bit rate
**Time window**

Specifies in seconds the **Time window** of the simulation. OptiSystem shares the parameter **Time window** with all components. This means that each component works with the same **Time window**. Since the **Time window** defines the frequency spacing in the frequency domain, the sampled signal will always have the same frequency spacing. This parameter is best expressed in terms of the sequence length and the bit rate used during the simulation. It affects all components.

**Sample rate**

Specifies the frequency simulation window or simulation bandwidth in Hz (see Figure 31). It can affect components such as pulse generators and optical sources that generate signals at different sample rates. It is often convenient to operate all modules in the design at the same sample rate. This can be done easily by using this global parameter. The default parameter for all components requiring sample rate is referred to as the global sample rate. When you change this global parameter, you can change the sample rate setting of all modules in the design simultaneously.
Sequence length

The length of the bit sequence in number of bits. It must be a power of two.

Figure 32 Global parameter Sequence length

Samples per bit

Number of samples for bit used to discretize the sampled signals. It must be a power of two.

Number of samples

This read-only parameter shows the number of samples calculated by the product of Sequence length and Samples per bit.
## Appendix A: Global Parameters

### Figure 33  Global parameter iterations

![CW Laser Properties dialog box with columns for Name, Value, Units, and Mode]

<table>
<thead>
<tr>
<th>Disp</th>
<th>Name</th>
<th>Value</th>
<th>Units</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enabled</td>
<td></td>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Iterations</td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td></td>
<td>Parameterized</td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td></td>
<td>Sample rate</td>
<td></td>
<td>Hz</td>
<td>Script</td>
</tr>
</tbody>
</table>

Label: CW Laser  
Cost: 0.00
## APPENDIX A: GLOBAL PARAMETERS

### Signals parameters

**Figure 34**  Global parameters Signals

![Layout 1 Parameters](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Units</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Iterations</td>
<td>1</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Initial delay</td>
<td></td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Parameterized</td>
<td></td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>Synchronize</td>
<td></td>
<td>Normal</td>
<td></td>
</tr>
</tbody>
</table>

**Layout 1 Parameters**

- Label: Layout 1

**Options:**
- Add Param...
- Remove Par...
- Edit Param...

**Additional Features:**
- OK
- Cancel
- Help
**APPENDIX A: GLOBAL PARAMETERS**

**Iterations**

Number of signal blocks generated by each simulation. It mainly affects transmitters and components used in bidirectional simulations and in network ring design.

By increasing the parameter iterations a component will repeat the previous calculation until the number of calculations is equal to the iterations. Refer to the tutorial lesson: *Working with multiple iterations*.

**Initial Delay**

This parameter forces a component to generate a null signal at each output port. It affects all components and it is mainly used in bidirectional simulations. The user does not have to add delays at the component input ports if using this parameter. Refer to the tutorial lesson: *Working with multiple iterations*.

**Parameterized**

Defines whether the signal output will be sampled signals (disabled) or parameterized signals (enabled). It can affect components such as optical sources and optical pulse generators.

**Synchronize**

Defines whether bit rates will be recalculated in order to make sure that the number of samples and the number of bits are both power of two numbers. It can affect components such as pulse generators, decoders and BER analyzers. It forces compatibility mode with previous versions of OptiSystem 7.
Noise parameters

Convert noise bins

Selects whether noise within a sampled band's frequency range is added to the sampled signal or represented separately as noise bins. The default value is disabled, which means the noise propagate is separated from the signals. It can affect the Erbium doped fiber amplifiers and the photo detectors.

Figure 35  Global parameters Noise
Spatial Effects Parameters

The spatial effects parameters affect the components that generate spatial modes, where the discretization space and the level of the discretization should be defined. The number of points per spatial mode is defined as the product of the number of points in the X and Y coordinates.

Figure 36  Global spatial effects parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Units</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space width X</td>
<td>50</td>
<td>μm</td>
<td>Normal</td>
</tr>
<tr>
<td>Space width Y</td>
<td>50</td>
<td>μm</td>
<td>Normal</td>
</tr>
<tr>
<td>Grid spacing X</td>
<td>0.5</td>
<td>μm</td>
<td>Normal</td>
</tr>
<tr>
<td>Grid spacing Y</td>
<td>0.5</td>
<td>μm</td>
<td>Normal</td>
</tr>
</tbody>
</table>

**Space Width X**
This is the space for the X coordinate.

**Space Width Y**
This is the space for the Y coordinate.
Grid Spacing Width X

The grid spacing for the X coordinate. The space width divided by the grid spacing gives the number of points in the X coordinate.

Grid Spacing Width Y

The grid spacing for the Y coordinate. The space width divided by the grid spacing gives the number of points in the Y coordinate.

Signal Tracing Parameters

OptiSystem allows for fast estimation of power and noise at each output port. This estimation is calculated every time a signal is sent to the component output port. The signal tracing parameters allow the user to control the calculation and presentation of the results.

Figure 37  Global signal tracing parameters
APPENDIX A: GLOBAL PARAMETERS

Calculate Signal Tracing
Defines if the signal will be traced.

Power Unit
The units used to display the results (dBm, W or mW).

Frequency Unit
The units used to display the results (Hz, m, THZ or nm).

Decimal Places
The number of decimal places to use when displaying the results.

Sensitivity
The minimum output power that the calculation can detect.

Resolution
The spectral resolution bandwidth of the calculation.

Calculate Noise Floor
Defines if the noise floor will be calculated using interpolation. This is an important parameter when the noise is added to the signal.

Interpolation Offset
The interpolation offset from the signal channel center frequency used to estimate the noise floor.
Appendix B: Signal representation

To make the simulation tool more flexible and efficient, it is essential that it provides models at different abstraction levels, including the system, subsystem, and component levels. OptiSystem features a hierarchical definition of components and systems, allowing you to employ specific software tools for integrated and fiber optics in the component level and allowing the simulation to go as deep as the desired accuracy requires. Different abstraction levels imply different signal representations. The signal representation must be as complete as possible in order to allow efficient simulation.

There are five types of signals in the signal library:

<table>
<thead>
<tr>
<th>Signal</th>
<th>Connection color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>Red</td>
</tr>
<tr>
<td>M-Ary</td>
<td>Dark Red</td>
</tr>
<tr>
<td>Electrical</td>
<td>Blue</td>
</tr>
<tr>
<td>Optical</td>
<td>Green</td>
</tr>
<tr>
<td>Any Type</td>
<td>Dark Green</td>
</tr>
</tbody>
</table>

Figure 38  Signal types and connections
APPENDIX B: SIGNAL REPRESENTATION

OptiSystem handles mixed signal formats in the Component Library for optical and electrical signals. It calculates the signals using different algorithms according to the desired simulation accuracy and efficiency.

Binary signals

Binary signals are generated by components such as bit sequence generators. Pulse generators in the Transmitters Library and digital switches in the Network Library use this signal as input data.

A binary signal consists of a sequence of ones and zeros, or marks and spaces. The main property of the binary signal is the Bit rate (see Figure 39).

Figure 39  Binary signal

M-Ary Signals

M-Ary signals are multilevel signals used for special types of coding, such as PAM, QAM, PSK, and DPSK. M-Ary signals are similar to the binary signals. However, M-Ary signals can have any level instead of only high (1) and low (0) levels, or marks and spaces. Refer to the digital modulation tutorial lessons.

Electrical signals

Electrical signals are generated by components such as pulse generators in the Transmitters Library and photodetectors in the Receivers Library.

Electrical signals consist of the sampled signal waveform in time domain. The main properties of the electrical signal are the signal noise variances in the time domain and the noise power spectral densities in the frequency domain.
When a pulse generator generates the electrical signal, there is no noise information with the signal because the signal is pure. If the electrical signal is generated by a photodetector, there are different sources of noise, some of which are time dependent and must be characterized by the time variance (for example, shot noise). Some of them are given as power spectral density (for example, thermal noise). The electrical signal creates the noise information according to the properties and the number of noise sources in the component (see Figure 40).

Figure 40 Electrical signal - noise variance - PSD

If the electrical signal is filtered, the noise PSD is affected immediately because the PSD is filtered based on the filter transfer function in frequency domain. If the noise is also characterized by the noise variance, it is not affected immediately. The information about the filter transfer function is saved in the frequency domain as a property of the noise. As a result, you can have a cascade of electrical filters and the electrical signal will keep track of the equivalent transfer function of the filters.

When using the noise variance for calculation of the signal noise, the information about the filters will be used to generate the equivalent noise bandwidth and will be applied to the noise variance (see Figure 41).

Electrical signals can also be represented by individual samples, allowing for time driven simulations. In order to simulate using individual samples the user should explicitly add the component “Convert to Individual Electrical Samples” into the layout. The signal and noise at the input signal will be added and converted into multiple samples. The number of samples is defined by the global parameter Number of samples. Refer to the tutorial lesson: Working with individual samples.
Optical signals

Optical signals are generated by components such as lasers in the Transmitters Library. Optical signals accommodate different signal representations:

- Sampled signals
- Parameterized signals
- Noise bins

Figure 42  Mixed optical signal representation - Frequency domain
Sampled signals

Optical signals can accommodate any arbitrary number of signal bands. In the simplest case, there is one single frequency band when a single, continuous frequency band represents the waveforms of all the modulated optical carriers. A single optical source (for example, CW Laser) produces a single frequency band. The band represents the complex sampled optical field of the signal in two polarizations. This type of optical signal is called a Sampled signal.

When two or more Sampled signals are combined, the individual signals will join into a new sampled signal if their simulation bandwidths overlap, or they are kept separated if the simulation bandwidth does not overlap. The resulting signal is called Sampled signals — in this case, each sampled signal is propagated using a separate sampled optical field.

Example

Signals are generated in each laser and are combined in the multiplexer. After the multiplexer, the channels at frequencies 193.1 and 193.2 THz overlap, so they are added to the same band (see Figure 43).

Sampled signals can also have spatial representation for the spatial modes. If you are using the multimode component library, the sampled signals will also have the spatial distribution of the signal power for both polarizations.

Optical signals can also be represented by individual samples, allowing for time-driven simulations. In order to simulate using individual samples, the user should explicitly add the component "Convert to Individual Optical Samples" into the layout. Only sampled signals can be converted into individual samples. The number of individual samples is defined by the global parameter Number of samples. If the input signal has multiple channels, each channel will have an individual sample and center frequency, allowing for WDM and Time-driven simulations. Refer to the tutorial lesson: Working with individual samples.
Parameterized signals

The signal description based on the Sampled signals covers the majority of physical phenomena affecting the system design. When designing a system where the power budget analysis and the fast signal-to-noise ratio estimations are the main performance evaluation results, signal channels can be approximated by their average power, assuming that the detailed waveform of their data streams are not important. One application example is the investigation of the transmission behavior of the central channels in dense WDM systems, or an estimation of the EDFA performance in the steady-state regime.

Parameterized Signals are time-averaged descriptions of the sampled signals based on the information about the optical signal (for example, Average power, Central frequency, and Polarization state).

Example

Signals are generated in each laser using parameterized representation and combined in the multiplexer. Signals are represented by power and frequency (see Figure 44).
In the typical simulation of optical amplifiers in a WDM system, the model of an EDFA uses the static solution of the rate equations. Each WDM channel is a sampled signal with the information about the signal waveform (for example, center frequency, sample rate and a large number of samples). The WDM channels are close to each other, and can be in separate channels or together in the same band using a total field approach. The center frequency of the signal pump is far from the signal channels, making it inefficient to include the pump in the same band as the signal channels. There is no information content in the bandwidth range between the channels and pumps. The signal pump is also a CW signal, and can be represented as a parameterized signal by such statistical parameters as its power and wavelength.

The other type of signal is the ASE generated by the amplifier, which can also be represented in an alternative way by the power spectral density of the ASE bandwidth instead of the sampled signal. OptiSystem separates noise and signals in the spectrum, describing the noise by modifying the parameterized signals to another signal representation — Noise bins.
APPENDIX B: SIGNAL REPRESENTATION

Noise bins

Noise bins represent the noise by the average spectral density in two polarizations using a coarse spectral resolution. The resolution can be adapted to maintain the accuracy of the simulation. The main advantage of using Noise bins is to cover the wide spectrum of the optical signals or to represent the noise outside the Sample signals bandwidths. The noise bin representation is similar to the parameterized signals, including the polarization. The main difference is that noise bins are defined by the noise power density and the bandwidth of each noise bin instead of by the average power (see Figure 45).

![Figure 45: Noise bins generated by EDFA](image)

Noise Bins can be created whenever there is a source of optical noise, such as optical amplifiers. You define the initial resolution and bandwidth of the noise (see Figure 46).
During transmission, the widths of the noise bins are adapted automatically to describe the filtering of the noise with a specified precision. The noise bins shrink in width as they propagate through the simulation in order to maintain the discretization accuracy (see Figure 47).
APPENDIX B: SIGNAL REPRESENTATION

Figure 47  Filtering noise bins – adaptive band of each bin